
HyperCard IIGS 1.1 

How to use the tools 
that take you to 
hypermedia heaven 

• 
by Cynthia E. Field, Ph.D. 

We wince at using the word hyperbole 
and HyperCard Iles in the same sentence ' but it's no exaggeration to say that this 
program is phenomenal. Thanks to 
HyperCard Iles, teachers and hobbyists 
can experience the exhilaration of 
creating their own graphically rich, 
full-color multimedia software - with 
or without mastering a single "bit" of 
programming code. 

HyperCard IIGs makes creating easy 
Within hours you can build a personalized 
hypermedia stack merely by tapping the 
abundant collection of ready-made card back­ 
grounds, clip art, buttons, and icons that 
HyperCard Iles supplies. 

It takes even less time to adapt the program's 
sample Birds, Story Board, and Picture Puzzler 
stacks. For instance, creating a jigsaw-type puz­ 
zle is as easy as selecting a full-screen painting 
such as the multicolor U.S. map that's included in 
the Art Ideas stack. At your command (just pull 
down the Puzzle menu with the mouse), Picture 
Puzzler scrambles the map into 25 random tiles. 
Use the mouse to reposition the map pieces cor­ 
rectly. Better yet, why not use HyperCard Ilos's 
paint tools - or import a digitized super hi-res 
photograph - to create picture puzzles with a 
personal touch? 

Tour, the animated introductory stack, features 
workers clad in overalls amid tool boxes and 
construction equipment, a perfect metaphor for 
this software environment. Although masterful 
stack-making, like masterful anything, necessi­ 
tates a heftier time commitment than described 

so far, poking around in HyperCard Ilcs's nooks 
and crannies is a lot like playing your favorite 
Apple II game. 

HyperCard Iles owes much of its ease of use to 
the unwavering support of Apple Human Inter­ 
face standards. Except for text, which you type, 
everything is mouse driven. You can select a 
ready-made button from the Tool Kit's Button 
Ideas stack and copy it to the Apple Ilos's Clip­ 
board simply by pulling down the Edit menu and 
selecting "Copy." Pull down the Go menu to 
determine the most direct route back to your 
stack. Pull down the Edit menu and choose 
"Paste." Drag the new button into position on the 
desired card (or its background). That's all there 
is to it. 

From organizing to fantasizing, Hyper(ard IIGS 
can help 
Tool Kit is just one of the five cards that make up 
the HyperCard Iles Home stack. Other cards 
include Welcome, Deskset, Attic, and Applica­ 
tions. From the Welcome and Deskset cards you 
can launch the sample stacks provided with the 
program. The Attic is a good place to include but­ 
tons quick-linking you to stacks you've created. 
Buttons you install on the Applications card 
shunt you to other programs. 

If you often think about getting your life orga­ 
nized (and who doesn't?), launch the Addresses 
and Calendar stacks from the Deskset card. 
These databases are both functional and good 
looking. Calendar is especially useful as an 
appointment (or school assignment) scheduler. 
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Graphical database stacks like Addresses and 
Calendar and imaginative ones like Story Board 
provide just the inspiration you need to design 
custom stacks for home, school, or business. At 
least one Apple enthusiast has compiled a gar­ 
dening stack to track information about plants in 
his home's landscape plan. And we suspect that 
more than a few teachers are working on 
HyperCard IIGs grade books. 

Either a dot matrix or laser printer is required to 
generate a hard copy of your daily "to do" list - 
or any other card you'd like to print. With the 
Image Writer II printer and a four-color ribbon 
you can print creations in color. Among other 
things, you can transform a Story Board story 
"stack" into a story "book" to share with friends 
and relatives who don't have HyperCard IIGS. 

Those of you who want to share your creations 
should save copies of your stacks on data disks. 
That way, your friends can browse through your 
stacks interactively and venture from card to card 
by clicking on buttons with the mouse. Among 
other things, HyperCard IIGs buttons link cards 
(or stacks), start animation sequences, sort infor­ 
mation, and calculate numbers. Other buttons 
generate sound effects, play music, or display a 
video sequence. 

Lest you think HyperCard IIGs is just for grown­ 
ups, 4-year-old Brian and 9-year-old Rochelle 
prove otherwise. The young collaborators 
crafted Story Board's medieval tale about a 
dragon that abducted a princess - and a queen 
to boot! The children composed an imaginative 
story line to accompany scenes, characters, and 
props that they borrowed from the Art Ideas 
stack. 
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HyperCard IIGs offers five levels of interaction 
with stacks: Browsing, Typing, Painting, Author­ 
ing, and Scripting. You set the level you want via 
the Home stack's User Preferences menu. A nov­ 
ice stack creator would probably work at the 
Authoring level. After some experience, you'll 
want to advance to Scripting. For a database 
stack you'd want to set the interaction level to 
Typing because you (or other users) need to be 
able to enter information into text fields. A his­ 
tory lesson stack, however, might be restricted to 
Browsing unless you don't mind students "edit­ 
ing" the information you present. If you need to 
ensure the absolute security of your work, 
HyperCard IIGs provides password protection. 

Add external devices for multimedia fun 
With no more equipment than an Apple IIGs, it's 
easy and fun to design and "publish" stacks like 
those we've described. But with peripheral 
devices, you can also create sophisticated CD­ 
ROM (compact disc read only memory) or video­ 
disc-based stacks with your HyperCard IIGs. 
Ready-to-use buttons in the HyperCard IIGs 
Media Control stack establish the necessary soft­ 
ware links to virtually any external device that 
you can physically attach to your Apple IIGs. 
Notable examples include the Apple SC CD-ROM 
drive, Pioneer 2000 or 4200 LaserDisc players, 
and the Apple II Video Overlay Card. Some 
industrial model VCRs work, too. 
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With these enhancements you can incorporate 
audio CD music into your stack, display graphics 
from a compact disc database, or play full­ 
motion video clips from a videodisc. The Video 
Overlay Card "genlocks" (merges) the videodisc 
image with the graphics and text elements in 
your stack and displays a combined image on 
your monitor. 

When you double-click on a button, or select 
Button Info from the Objects menu, a descriptive 
dialog box opens. Among other things, you can 
name the button and choose an icon for it. 
(HyperCard IIGs's Tool Kit includes an Icon Edi­ 
tor for drawing custom icons.) You can select any 
of 16 palette colors for each attribute when color­ 
izing a button's frame, background, and text. 

NeJ,,., 11 Deskstl I Mffl•M I Allie 11 Applicalions I 

A cascading menu in the Button Info dialog box 
lets you choose among seven button styles: 
transparent, opaque, rectangle, shadow, round 
rectangle, check box, or radio button. Other But­ 
ton Info options let you link the button to any 
card or stack. Click on "Script" and you can write 
a custom HyperTalk script. Similar options 
appear when you request Field Info. 
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HyperCard IIGS supports bit-mapped graphics 
Besides object-oriented graphics capabilities, 
HyperCard IIGs supports bit-mapped (paint) 
graphics. Two pull-down (or floating) palettes 
display the 15 tools, 16 colors, and 16 patterns 
with which you can design original artwork for 
cards and their backgrounds. As you may recall, 
a background can be unique to an individual 
card, but it's usually more efficient to use a com­ 
mon background for a series of cards. 

Object-oriented graphics increase the 
possibilities 
As you grow with HyperCard IIGs, you'll enjoy 
ample opportunities to explore the program's 
object-oriented and bit-mapped graphics tools 
as well as its powerful HyperTalk scripting 
language. 

Like most hypermedia programs, including 
HyperCard for Macintosh computers, 
HyperCard IIGs stacks are composed of graphical 
objects. These include cards, the basic building 
blocks of a stack. Inserting a new card in your 
stack is as easy as copying a card you previously 
designed or beginning with a clean slate. But­ 
tons, of course, are objects. So are fields - 
including scrollable ones - in which you type 
textual information you wish to present. Adding 
a button or a field to a card is no more difficult 
than clicking on the Button or Field tool icon 
that's displayed in the Tools menu. 

The unique Media Control Window tool palette 
looks like the control panel on a VCR. Buttons 
labeled Stop, Pause, Rewind, Step Backward, 
Play, Step Forward, Fast Forward, Jump, and 
Eject make it easy even for novices to select the 
clips they wish to include in their stacks. 

Tools menu 
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The Lasso or Selection tool segregates a part of 
the painting you'd like to cut (delete) or change. 
With the lasso, it's easy to copy the picture of the 
oak leaf, say, from the Art Ideas stack. Paste the 
leaf into a background scene. Paste a series of 
leaves. Then rotate and flip the graphics in 
assorted ways to create an autumn scene. Color 
the leaves with fall hues. Experiment with 
opaque and transparent paint. 

Like standard GS paint programs, HyperCard IIGs 
offers shape tools that let you create lines, boxes, 
round corner boxes, ovals, curves, and polygons. 
A free-form drawing Pencil and assorted brushes 
(including an airbrush Spray tool) are provided, 
as well. A Paint Text tool (for creating graphical 
text), an Eraser, and a Paint Bucket tool (for 
color-fills) complete the graphics toolkit. A Fat­ 
Bits mode (Options menu) lets you perform 
pixel-size touchups. 

Among popular HyperCard IIGs features is the 
capability to choose a separate color palette for 
different cards. The program offers five ready-to­ 
use palettes. Three feature bright colors, one 
includes pastels, and one is grayscale. Whether 
you want teal or turquoise, you'll find it. 

You can edit any of HyperCard IIGs's 16 patterns 
by double-clicking on the selected pattern. A 
pop-up pattern editor appears. Choose a color 
from the mini paint palette, which is included, 
and click appropriate pixels in the FatBits pattern 
window. A sample pattern window instantly dis­ 
plays the changes you make. 

HyperTalk speaks an English dialect 
It may sound like just another hyperbole, but 
HyperCard IIGs includes the most powerful 
Apple II hypermedia scripting language there is. 
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But thanks to the program's graphical working 
environment, its sample stacks, and its ready-to­ 
use buttons you don't have to learn HyperTalk 
unless you want to. 

Technically speaking, when you write a script in 
HyperTalk, you are programming. But it's pain­ 
less because HyperTalk speaks an English dia­ 
lect. Many HyperTalk commands use the exact 
same syntax we do. A HyperTalk button script, in 
part, might read, "go to card 4." What could be 
easier? 

Some HyperTalk syntax takes getting used to, 
though. In the example above, you also have to 
tell HyperCard IIGS when to go to card 4. One 
way to do that is to precede the statement above 
with another that reads "on mouseUp." It's not 
too much of a stretch of the imagination to realize 
that the command refers to the user's releasing 
the mouse button. 

HyperTalk scripts can play music when a card 
opens ("on openCard"). After typing the "play" 
command, enter the name of the musical instru­ 
ment you've chosen. Ready-to-use instrument 
sound "resources" are stored in the Scripter's 
Tools stack. Complete the script by composing 
the music you'd like to hear. 

HyperTalk doesn't use standard musical nota­ 
tion. Instead you type keyboard characters that 
correspond to each note's pitch and duration. 
HyperCard II Gs does not inherently support MIDI 
(musical instrument digital interface) files, but at 
least one developer is said to be preparing an 
XCMD that does. (An XCMD is an extended com­ 
mand written with a traditional programming 
language such as assembly, C, or Pascal.) 



• 
Hypermedia authors can 

further streamline 
the stack-development 

system ... 
• 

HyperTalk makes it easy to incorporate interest­ 
ing visual effects in your stacks. We've animated 
scenes with the "show" command and imple­ 
mented attractive transitions between cards with 
the "visual" command. Among the transitions 
you can use: barn door close, dissolve, fade, 
scroll down, venetian blind, wipe right, and 
zoom out. 

HyperCard IIGs scripts do a lot more than "just" 
play monophonic music or perform attractive 
visual tricks. Other scripting commands let you 
pose a question (and answer it), dial a telephone 
number, hide (or show) card and background 
elements, or read from selected files. HyperTalk's 
mathematical, trigonometric, financial, date, and 
time functions might remind you of a spread­ 
sheet's. Other scripting language elements let 
you track the location of the mouse, determine 
the name of the currently selected tool, execute 
logical (if, then, else) statements, or control 
object properties such as highlighting, color, 
alignment, and locking. 

New version is quicker than its predecessor 
Graphics-intensive programs are often thought 
to be sluggish memory hogs. HyperCard IIGS isn't 
one of them. The program requires only 1.5 MB 
of RAM (random access memory); 2 MB or more 
are recommended, however. The program also 
requires a hard disk drive or a network. The 
capacity of a hard disk drive isn't critical, but its 
interface ideally should be a fast SCSI (small 
computer system interface) controller such as 
the Apple II High Speed SCSI Card. Though 
HyperCard IIGS is disk-intensive, virtual memory 
management greatly reduces the frequency of 
disk drive accesses. 
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Power users claim that ultimate hypermedia 
systems should be equipped with accelerator 
cards, such as those manufactured by Applied 
Engineering or Zip Technology. (For more 
information on accelerator cards, see the 
"Accelerating Your Apple" article in the 
Making the Most of Your Apple II chapter.) Even 
without an accelerator, however, this newest 
version of H yperCard II Gs 1.1 is noticeably faster 
(as much as four times faster in some cases) than 
its predecessor. 

Hypermedia authors can further streamline the 
stack-development process by using quick key 
commands such as "Open Apple-2" and "Open 
Apple-3," which display a stack's Previous and 
Next cards, respectively. The program's Recent 
option (use Open Apple-R or the Go menu) is 
another handy way to navigate through Hyper­ 
Card IIGs stacks. When you invoke this feature, 
the program displays as many as 18 miniature 
illustrations representing cards you recently 
viewed. 

You can convert the Go menu to a floating pal­ 
ette where symbols substitute for words. Click on 
the right arrow to go to the next card, on the grid 
icon to view recent cards, or on the home icon to 
go to the Home card. An efficient way to interact 
with HyperCard IIGs is to memorize a manage­ 
able number of keyboard speed-up commands, 
use floating palettes whenever possible, and 
pull-down menus only when you need to. 

H yperCard II Gs intermittently saves your work in 
progress, so it's virtually impossible to lose any 
important changes you make to buttons or fields. 
Click on the Keep option (Paint menu) when 
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you're working on paintings, however; 
HyperCard lIGS doesn't save bit-mapped changes 
as frequently as object-oriented ones. 

The "Save a Copy" feature in the File menu lets 
you create backups or copies of your stack for 
friends using HyperCard Iles. The latest version 
of GS/OS-Apple lIGS system software 6 - for­ 
mats data disks as you need them. Apple Iles 
system software 6 is also required if you plan to 
use the Media Control functions described 
earlier. Otherwise, System 5.0.4 will suffice. 
(For more information on Apple Iles System 
Software 6, see the "System 6: The Future is Here" 
article in the Understanding Technical Informa­ 
tion chapter.) 

Manuals explain all the details 
HyperCard Iles software is accompanied by 
three spiral bound manuals. The colorful and 
well-written Getting Started guide, a self­ 
described "manual for the playful," provides 
a beginner's tour of the program. The 
comprehensive, 389-page reference covers 
additional details. A separate guide is devoted 
to HyperTalk scripting. 

Reference and Scripting guides feature perfo­ 
rated, tear-out quick reference cards listing key­ 
board shortcuts, modifier keys, and HyperTalk 
commands. On-line help is always available - 
whether you're exploring the basics or delving 
into the Scripter's Tools stack to use XCMDs and 
XFCNs (extended functions). 

94 • THE APPLE II GUIDE 

Topics 
I. Click o topic ... 

HyperCard Basics 
T11pins 
Pointing 
Printing 
Buttons 
Fit Ids 
Cards 
Backgrounds 
Stocks 
Mtnu Reference 

There are easy ways to start with 
Hyper(ard IIGs 
One of the best ways to become proficient with 
HyperCard Iles is to play with stacks other 
enthusiasts have designed. Local user groups 
often boast one or two hypermedia experts who 
are happy to share their collection with group 
members. The Apple User Group Connection (1- 
800-538-9696, extension 500) can help steer you 
to groups in your area. You can also download 
public domain stacks from bulletin board sys­ 
tems and on-line services, such as those we 
describe in the "On-line Services" article in the 
Information Resources chapter. 

Commercial quality stacks are available from 
Resource Central. (See the listings in the "Books 
and Periodicals" article in the Information 
Resources chapter.) Like a magazine, each 
bimonthly, two-disk issue of Script-Central 
includes a Scripter's Workshop column and arti­ 
cles covering HyperCard Iles "tips and tricks." 
Unlike a magazine, Script-Central provides sev­ 
eral ready-to-use stacks. 
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Although you can't automatically use a 
friend's Macintosh HyperCard stacks with 
H yperCard Iles, HyperMover- a software utility 
that dismantles and rebuilds Macintosh Hyper­ 
Card stacks - makes them compatible with 
HyperCard Iles. But HyperMover can't work mir­ 
acles: Macintosh HyperCard doesn't support 
color, for example. 

Give it a test drive 
Once you start using HyperCard Iles 1.1, you'll 
want to launch hypermedia projects of your own. 
You'll find the program's object-oriented and bit­ 
mapped graphics tools a delight to use. And 
you'll probably be surprised that the HyperTalk 
scripting language is so much like the language 
you already speak. The only thing you might not 
be able to figure out is how this extraordinary 
program does so much, yet costs so little. 

Cynthia E. Field, Ph.D., is a freelance journalist specializ­ 
ing in computer-related topics. She has written about 
Apple II computers since 1982. Thanks to Apple Software 
Engineer and HyperCard Iles guru Darin Acquistapace 
who graciously provided technical assistance during the 
preparation of this article. 
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